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Las Instrucciones de uso (IFU, por sus siglas en inglés) ofrecen información al usuario sobre el 

propósito previsto del software, su uso adecuado y las precauciones que se deben tener. Además, 

incluye la información general del producto y la información necesaria para identificar el 

dispositivo y su fabricante. 

 

Toda la información relevante sobre seguridad y rendimiento para el usuario se indica en estas 

instrucciones, y se describen los riesgos residuales. Leer detenidamente este manual antes de 

usar el software.  

 

Este es un documento electrónico, se puede descargar una copia aquí 

www.hermesmedical.com/ifu. Las copias impresas de las Instrucciones de uso, los Requisitos del 

entorno del sistema y las Notas de la versión están disponibles de forma gratuita (tantas como 

licencias se hayan adquirido) bajo solicitud. 

 

Estas instrucciones contienen ADVERTENCIAS sobre el uso seguro del producto. Su cumplimiento 

es obligatorio. 

 

   Este es el símbolo de advertencia estándar. 

 

 

NOTA: la nota proporciona información adicional para tener en cuenta, por ejemplo, 

aspectos que se deben considerar al realizar un determinado procedimiento. 

 

 

Las Instrucciones de uso y el software en sí están protegidos por derechos de autor, y todos los 

derechos están reservados por Hermes Medical Solutions. Ni el software ni el manual se pueden 

copiar ni reproducir de ninguna otra forma sin el consentimiento previo por escrito de Hermes 

Medical Solutions, quien se reserva el derecho de realizar cambios y mejoras en el software y en 

el manual en cualquier momento. 

Hermes Medical Solutions*, HERMIA*, el logotipo de HERMIA* y SUV SPECT* son marcas 

registradas de Hermes Medical Solutions AB. 

Las marcas registradas de terceros que se utilizan en este documento son propiedad de sus 

respectivos propietarios, quienes no están afiliados a Hermes Medical Solutions. 

 

*Sujeto a registro en algunos mercados. 

 

 

 

 

 

 

 

http://www.hermesmedical.com/


Hybrid Recon 5.0.0   2 (54) 

P21-027 Instrucciones de uso de Hybrid Recon 5.0.0 Rev.2_SP 

Número del documento> 

Tabla de contenidos 

1 INTRODUCCIÓN .................................................................................................................. 3 
1.1 NOTAS GENERALES ............................................................................................................................................ 3 
1.2 INFORMACIÓN NORMATIVA ................................................................................................................................. 3 
1.3 DOCUMENTACIÓN ASOCIADA ............................................................................................................................... 3 

2 INFORMACIÓN DEL PRODUCTO ......................................................................................... 4 
2.1 OBJETIVO PREVISTO ........................................................................................................................................... 4 
2.2 GRUPO DE PACIENTES PREVISTO Y CONDICIONES MÉDICAS ......................................................................................... 4 
2.3 CONTRAINDICACIONES ....................................................................................................................................... 4 
2.4 ETIQUETA DEL PRODUCTO ................................................................................................................................... 4 
2.5 VIDA ÚTIL DEL PRODUCTO ................................................................................................................................... 5 
2.6 QUEJAS E INCIDENTES GRAVES ............................................................................................................................. 6 
2.7 HARDWARE Y SISTEMAS OPERATIVOS .................................................................................................................... 6 
2.8 INSTALACIÓN .................................................................................................................................................... 6 

2.8.1 Advertencias ............................................................................................................................................ 6 

3 INFORMACIÓN SOBRE SEGURIDAD Y RENDIMIENTO ......................................................... 7 
3.1 PUESTA EN MARCHA .......................................................................................................................................... 7 
3.2 INICIO RÁPIDO .................................................................................................................................................. 7 

3.2.1 Flujo de trabajo de oncología .................................................................................................................. 7 
3.2.2 Flujo de trabajo de neurología ............................................................................................................... 15 
3.2.3 Flujo de trabajo de pulmón .................................................................................................................... 25 
3.2.4 Flujo de trabajo de cardiología .............................................................................................................. 35 

3.3 INTERFAZ ....................................................................................................................................................... 46 
3.4 SEGURIDAD .................................................................................................................................................... 47 
3.5 ADVERTENCIAS ............................................................................................................................................... 47 

4 INFORMACIÓN DE CONTACTO .......................................................................................... 50 
4.1 INFORMACIÓN DE CONTACTO DEL FABRICANTE ...................................................................................................... 50 
4.2 REPRESENTANTES ............................................................................................................................................ 50 
4.3 FILIALES......................................................................................................................................................... 50 

5 ANEXO 1 - CONTENIDO REQUERIDO PARA LA FORMACIÓN DE USUARIOS ..................... 51 
6 ANEXO 2 - MENSAJES DE ADVERTENCIA EN LA APLICACIÓN .......................................... 52 
 



Hybrid Recon 5.0.0   3 (54) 

P21-027 Instrucciones de uso de Hybrid Recon 5.0.0 Rev.2_SP 

Número del documento> 

La modificación del producto no está permitida y puede resultar en situaciones peligrosas. 

Solo el personal de servicio que esté debidamente capacitado por un distribuidor autorizado o por 

Hermes Medical Solutions deberá realizar las instalaciones y el servicio de este producto. 

Todos los usuarios deben recibir formación, por parte del personal de un distribuidor que esté 

autorizado o de Hermes Medical Solutions, sobre las funcionalidades básicas del software antes 

de su uso. Ver lista de funcionalidades básicas en Appendix 1 - User Training Required Content 

[Anexo 1 - Contenido que se requiere para la formación del usuario] 

Hermes Medical Solutions no valida ni garantiza los protocolos, guiones y programas que se 

proporcionan por el usuario. La parte que emplea estos programas es la única responsable de los 

resultados. 

Hermes Medical Solutions no asume ninguna responsabilidad por la pérdida de datos. 

Los usuarios del software son los únicos responsables de su uso y de los diagnósticos 

resultantes. Hermes Medical Solutions no asume ninguna responsabilidad por los resultados y 

diagnósticos que deriven del uso del programa que se describe o de la información que contiene 

este manual. 

Europa - Este producto cumple con el Reglamento europeo de productos sanitarios (MDR) 

2017/745. Está disponible bajo solicitud una copia de la correspondiente Declaración de 

conformidad. 

  

Número SRN europeo 

El número de registro único (SRN, por sus siglas en inglés) = SE-MF-000023032 se ha emitido a 

Hermes Medical Solutions, como se requiere por el Reglamento europeo de productos sanitarios 

MDR de la UE  2017/745. 

  

• P21-050 Notas de la versión de Hybrid Viewer 5.0.0 Rev.2 

• PC-007 Requisitos del entorno del sistema, la revisión que aplique se puede encontrar en 

www.hermesmedical.com/ifu. 

 

La guía para el usuario se diseñó para ayudar a los usuarios a utilizar el software y está 

disponible en la función Help [Ayuda] en el propio software. 

1 INTRODUCCIÓN 

1.1 Notas generales 

1.2 Información normativa 

1.3 Documentación asociada 

http://www.hermesmedical.com/ifu
http://www.hermesmedical.com/ifu
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Uso previsto 

Hybrid Recon es un software de aplicación para medicina nuclear. Según la información que el 

usuario proporciona, Hybrid Recon reconstruye estudios de adquisición de imágenes de medicina 

nuclear. Los resultados se pueden almacenar para un futuro análisis. El software de aplicación se 

puede configurar con base en las necesidades del usuario. Hybrid Recon también se puede 

utilizar de forma alternativa para evaluar la calidad de los estudios que se adquieren y realizar 

correcciones de movimiento cuando sea necesario, así como para producir estudios reconstruidos 

cuantitativos de SUV (valor de captación estandarizado).  

  

Usuario previsto 

Los usuarios previstos de Hybrid Recon son profesionales médicos que están capacitados en el 

uso del sistema.  

Pacientes de cualquier edad y género que se someten a investigaciones de imagen molecular.   

  

Todas las condiciones médicas para las que se realizan imágenes SPECT de medicina nuclear. 

Los ejemplos de cómo los estudios reconstruidos por Hybrid Recon pueden ayudar en el 

tratamiento de pacientes incluyen evaluar la circulación, función y salud del corazón, la actividad 

cerebral en pacientes con Parkinson o demencia, las condiciones de pacientes con infecciones, 

tumores raros o problemas óseos, y la circulación y respiración de los pulmones para 

diagnosticar embolia pulmonar o problemas en los lóbulos pulmonares. 

No existen contraindicaciones. 

El número de versión, la identificación única del dispositivo (UDI, en inglés) y otros datos del 

producto del software Hybrid Recon 5.0 instalado se pueden encontrar al hacer clic en el logotipo 

de Hermes Medical Solutions en la parte superior izquierda de la aplicación. 

 

Se puede identificar la siguiente información: 

  

Nombre del producto = Hybrid Recon 

Versión de lanzamiento = 5.0.0 

Nombre comercial = Hermia SPECT Reconstruction 

Número de compilación del software = 193 

  

 

«Prescription only» [Uso exclusivo bajo prescripción médica] - dispositivo restringido 

para su uso únicamente por, o bajo la orden de, un médico. 

 

Fecha de fabricación (DD-MM-AAAA) 

 

Número del identificador único del producto. 

2 INFORMACIÓN DEL PRODUCTO 

2.1 Objetivo previsto 

2.2 Grupo de pacientes previsto y condiciones médicas 

2.3 Contraindicaciones 

2.4 Etiqueta del producto 
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Indica que el producto es un aparato médico. 

 

Mercado CE y número de Organismo Notificado. 

 

Consultar las Instrucciones de uso (IFU). 

@ Direcciones de correo electrónico de asistencia. 

 

Información de contacto del fabricante. 

 

Representante autorizado en Suiza. 

  

 

La vida útil de Hybrid Recon 5.0 es de 5 años.  

  

El período de vida útil de 5 años comienza a partir de la fecha de fabricación de Hybrid Recon 

5.0.0 (5 años a partir de la fecha de fabricación de 5.0.0). Es posible que los parches que 

apliquen a Hybrid Recon 5.0 tengan nuevas fechas de fabricación, pero la vida útil no comenzará 

de nuevo a partir de la fecha de fabricación del parche. 

  

Durante la vida útil que se indica, Hermes Medical Solutions mantiene la seguridad y el 

rendimiento de Hybrid Recon 5.0. Se proporcionan parches si es necesario para mantener la 

seguridad y el rendimiento del producto. 

 

 

 

 

 

2.5 Vida útil del producto 
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Para el informe sobre los incidentes y los errores de nuestro soporte, ver Contact Information 

[Información de contacto]. 

  

Cualquier incidente grave que haya ocurrido en relación con el dispositivo se debe informar al 

fabricante. 

  

En función de las regulaciones que apliquen, los incidentes también se pueden informar a las 

autoridades nacionales competentes. En el ámbito de la Unión Europea, los incidentes graves se 

deben informar a la autoridad competente del Estado miembro de la UE en el que se encuentre el 

usuario o el paciente. 

  

Hermes Medical Solutions agradece los comentarios de los lectores de este manual. Por favor, 

informar de cualquier error en el contenido o tipografía y sugerencias de mejoras para nuestro 

soporte, ver la Contact Information [Información de contacto]. 

Para requisitos generales, consultar PC-007 Requisitos del entorno del sistema. 

La instalación debe cumplir con los requisitos que apliquen, tales como, pero sin limitarse a, los 

requisitos del sistema, configuración y licencias. 

 

Modification of the product is not allowed and may result in hazardous situations. 

La modificación del producto no está permitida y puede resultar en situaciones 

peligrosas. 

 

 

Only properly trained service personnel by an authorized dealer or by Hermes 

Medical Solutions, shall perform installations, and service of this product. 

Solo el personal de servicio que esté debidamente capacitado por un distribuidor 

autorizado o por Hermes Medical Solutions deberá realizar las instalaciones y el servicio 

de este producto. 

 

 

User provided protocols, scripts and programs are not validated nor warranted by 

Hermes Medical Solutions. The party using such programs is solely responsible for 

the results. 

Hermes Medical Solutions no valida ni garantiza los protocolos, guiones y programas 

que se proporcionan por el usuario. La parte que emplea estos programas es la única 

responsable de los resultados. 

 

 

No other, than Hermes Medical Solutions approved, applications shall be installed 

on the computer device for which Hermes Medical Solutions applications are 

intended to be used. Use of other applications may result in impaired performance 

and, in the worst case, incorrect output data. 

En el dispositivo informático para el que están destinadas las aplicaciones de Hermes 

Medical Solutions no se instalarán más aplicaciones que las que estén aprobadas por 

Hermes Medical Solutions. El uso de otras aplicaciones puede reducir el rendimiento y, 

en el peor de los casos, en la obtención de datos incorrectos.  

  

2.6 Quejas e incidentes graves  

2.7 Hardware y sistemas operativos 

2.8 Instalación 

2.8.1 Advertencias 
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Seleccionar el SPECT (o SPECT de múltiples posiciones) e iniciar la aplicación Hybrid Recon. 

  

Si hay CT (tomografía computarizada) disponible. Seleccionar CT, la exploración SPECT (o SPECT 

de múltiples posiciones) e iniciar la aplicación Hybrid Recon. 

    

 

En la pestaña «Recon» [Reconstrucción], se puede elegir el protocolo de reconstrucción con el 

cuadro desplegable en el lado derecho del protocolo de reconstrucción «Primary» [Principal]. Es 

posible realizar reconstrucciones adicionales del mismo estudio, al activar los botones de opción 

«Secondary» [Secundario] y «Tertiary» [Terciario]. Se puede elegir el protocolo de reconstrucción 

de la reconstrucción adicional con el cuadro desplegable junto al protocolo de reconstrucción 

«secondary» [secundario] y «tertiary» [terciario]. 

  

 
  

3 INFORMACIÓN SOBRE SEGURIDAD Y RENDIMIENTO 

3.1 Puesta en marcha 

3.2 Inicio rápido 

3.2.1 Flujo de trabajo de oncología 

3.2.1.1 Página de reconstrucción 
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Al arrastrar las líneas horizontales hacia arriba y hacia abajo en la imagen de cine, se cambiará el 

tamaño del campo de reconstrucción. 

  

 
  

La imagen del cine de las proyecciones de SPECT se puede iniciar, detener, mover hacia adelante, 

hacia atrás o en reversa, utilizando los botones multimedia «Play» [Reproducir], «Stop» [Detener], 

etc. Se puede evaluar cualquier movimiento en la proyección consultando las imágenes 

«Sinogram» [Sinograma] y «Linogram» [Linograma]. 

  

 
  

La pestaña «Moco» [Corrección de movimiento] permite realizar la corrección de movimiento del 

estudio SPECT. Hay tres tipos de corrección de movimiento que están disponibles: «Auto (y-only)» 

[Automático (solo y)], «Auto (x and y)» [Automático (x e y)] y «Man» [Manual]. Con los botones de 

opción, se puede cambiar el tipo de corrección de movimiento. 

  

 
  

La sección «Auto» [Automático] estará disponible si se selecciona un tipo de corrección de 

movimiento automático. El botón «Start» [Iniciar] permite realizar una corrección de movimiento 

automática. El botón «Undo» [Deshacer] restaura las proyecciones originales. El botón «Show» 

[Mostrar] permite mostrar la ventana «MoCo» [Corrección de movimiento]. Cuando no se ha 

aplicado ninguna corrección de movimiento, este botón aparece en gris. 
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Presionar «Start» [Iniciar] para iniciar la corrección de movimiento automática. Aparecerá una 

ventana «HybridRecon-MoCo» [HybridRecon-Corrección de movimiento] cuando finalice la 

corrección de movimiento. En esta ventana se mostrará una representación visual de los cambios 

de corrección de movimiento que realicen en la proyección MoCo (corrección de movimiento). Se 

pueden comparar las proyecciones originales con las proyecciones SPECT MoCo con los botones 

multimedia. 

  

El botón «Screen Capture» [Captura de pantalla] permite guardar una captura de pantalla de la 

ventana de MoCo. Pulsar la cruz en la parte superior derecha de esa ventana para cerrar el 

cuadro de MoCo. 

  

 
  

La sección «Man» [Manual] estará disponible si el «Moco type» [Tipo de corrección de 

movimiento] está configurado en manual («Man» [Manual]). La proyección se puede mover 

usando las flechas. Si el botón de opción «One frame only» [Un solo fotograma] está activado, el 

cambio se aplicará solo a un fotograma. Se pueden utilizar los botones multimedia, los controles 

deslizantes o la rueda del ratón (si el cursor está sobre la imagen de cine) para cambiar la 

proyección. 
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Se puede seleccionar un rango de proyecciones para mover de forma manual utilizando los 

campos «From frame» [Desde fotograma] y «To frame» [Hasta el fotograma]. 
  

  

 
  

Se puede guardar una copia de las proyecciones corregidas por movimiento haciendo clic en el 

botón «Save» [Guardar]. El botón «Screen Capture» [Captura de pantalla] guarda una captura de 

pantalla de las imágenes de cine, sinograma y linograma. 

  

La herramienta «Moco» [Corrección de movimiento] aparece en gris si se ha cargado una 

adquisición SPECT de múltiples posiciones. 

  

La pestaña «Noise» [Ruido] permite agregar ruido de disparo a la proyección. 

  

 

En la página de registro conjunto, se puede realizar un control de calidad de alineación de SPECT-

CT.  

  

En la sección «Display» [Pantalla], el campo «Zoom» [Zoom] permite aplicar un factor de Zoom 

específico a las vistas de fusión transversal, coronal y sagital. Cuando el botón de opción 

«Triangulate» [Triangular] está activo, se puede triangular en las vistas TCS con un solo clic 

izquierdo en cualquier vista. 

  

 
  

En la sección «Transformation» [Transformación], se puede elegir entre tres técnicas de 

alineación diferentes: 

  

• «Automatic full 6 parameter» [Automático completo de 6 parámetros] permite realizar un 

registro conjunto de forma automática de los ejes X, Y, Z y las rotaciones. 

• «Automatic translation only» [Solo traducción automática] permite realizar un registro 

conjunto de forma automática de los ejes X, Y y Z. 

• «Manual» [Manual] permite realizar un registro conjunto de forma manual. 

3.2.1.2 Página de registro conjunto SPECT-CT 
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En la sección «Transformation parameters» [Parámetros de transformación] se mostrarán los 

valores del movimiento del registro conjunto en los campos «X-shift» [Cambio X], «Y-shift» 

[Cambio Y], «Z-shift» [Cambio Z], «Transverse rotations» [Rotaciones transversales], «Coronal 

rotation» [Rotación coronal] y «Sagittal rotation» [Rotación sagital].  

  

El botón «Apply» [Aplicar] realizará los cambios de registro conjunto. Si se activa un tipo de 

transformación automática, al hacer clic en «Apply» [Aplicar] se realizarán los cambios del 

registro conjunto de forma automática. 

  

Si se activa el tipo de transformación «Manual» [Manual], será necesario introducir de forma 

manual los valores en los campos «Transformation parameters» [Parámetros de transformación] 

para permitir los cambios. 

  

Los cambios del registro conjunto se pueden deshacer utilizando el botón «Undo» [Deshacer]. 

  

 
  

Cuando «Transformation type» [Tipo de transformación] se configura en manual, se puede 

arrastrar CT sobre las imágenes SPECT moviendo el ratón sobre las vistas TCS (transversal, 

coronal y sagital). 

  

El botón «Screen capture» [Captura de pantalla] permite guardar una captura de pantalla de la 

imagen de los cambios del registro conjunto. Si la opción «Save mumap» [Guardar mapa de 

atenuación] está habilitada, el botón estará activo y permitirá guardar una copia del mapa de 

atenuación. El botón «Continue reconstruction» [Continuar reconstrucción] permite continuar el 

proceso de reconstrucción. 
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El menú desplegable «Color Table» [Tabla de colores] en la sección «Emission study colors» 

[Colores del estudio de emisión] permite cambiar la paleta de colores SPECT. Los límites de 

umbral inferior y superior se pueden cambiar utilizando los controles deslizantes «LT» [Umbral 

inferior] y «UT» [Umbral superior]. 

Los controles deslizantes «Level» [Nivel] y «Window» [Ventana] en la sección «Transmission study 

colors» [Colores del estudio de transmisión] permiten cambiar la ventana de CT. El control 

deslizante «Alpha» [Alfa] permite realizar una transición gradual entre el SPECT en el extremo 

izquierdo y el CT en el extremo derecho. 

  

 

Hay una opción para omitir esta página. 

  

En la página de filtro, se puede cambiar el filtro aplicado a un SPECT reconstruido. 

  

Se puede seleccionar el conjunto de datos en el que se quiera aplicar el filtro utilizando el menú 

desplegable «Dataset» [Conjunto de datos] en la sección «data» [datos]. 

  

En la sección «Display» [Pantalla], el campo «Zoom» [Zoom] permite elegir el Zoom aplicado en la 

vista de pantalla de inicio de la derecha. Los botones de opción «Trans» [Transversal], «Coro» 

[Coronal], «Sag» [Sagital] y «TCS» [TCS] permiten elegir qué vista(s) se mostrará(n) en el área de 

inicio derecha. 

  

En la sección «Filter» [Filtro], se puede cambiar el tipo de filtro. Hay cuatro tipos disponibles: 

Gaussiano, Butterworth, Hanning y Hamming. Los campos «FWHM [cm]» [Anchura a media altura 

FWHM [cm]], «Cutoff [1/cm]» [Corte [1/cm]] y «Order» [Orden] están disponibles y se pueden 

modificar si es necesario. Los campos disponibles se modificarán según el tipo de filtro. 

  

El botón «Apply» [Aplicar] aplicará los cambios del filtro que estén personalizados al conjunto de 

datos SPECT. 

  

3.2.1.3 Página de filtro 
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Hay una opción para omitir esta página. 

  

Esta página está destinada a generar imágenes estáticas/WB de reproyección desde el AC 

SPECT. 

  

En la sección «Protocol» [Protocolo], el menú desplegable «Protocol» [Protocolo] permite elegir 

entre diferentes protocolos de reproyección. Al hacer clic en el botón «Show Parameters» [Mostrar 

parámetros], se abrirá una ventana «Reprojection parameters» [Parámetros de reproyección] que 

permitirá ver qué ajustes de reproyección están configuradas para ese protocolo. 

  

Las reproyecciones se generarán al hacer clic en el botón «Perform re-projection» [Realizar 

reproyección]. Las reproyecciones que se generan se pueden eliminar haciendo clic en el botón 

«Undo re-projection» [Deshacer reproyección]. 

  

3.2.1.4 Página de reproyección 
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En la sección «Display» [Pantalla], el campo «Zoom» [Zoom] permite elegir el factor de aumento 

que se aplica en la vista de pantalla de inicio de la derecha. Los botones de opción «Trans» 

[Transversal], «Coro» [Coronal], «Sag» [Sagital] y «TCS» [TCS] permiten elegir qué vista(s) se 

mostrará(n) en la sección de inicio de la derecha. 

  

Los botones de opción «1st dataset» [1.er conjunto de datos], «2nd dataset» [2.º conjunto de 

datos] y «3rd dataset» [3.er conjunto de datos] permiten elegir qué serie se mostrará en la sección 

de inicio de la derecha. 

  

 
  

  

En la sección «Save» [Guardar], se puede introducir una etiqueta en los campos «1st label» [1.ª 

etiqueta], «2nd label» [2.ª etiqueta] y «3rd label» [3.ª etiqueta]. Después de guardar, este texto se 

agregará a la etiqueta correspondiente de la serie SPECT. 

  

Se pueden guardar las reconstrucciones haciendo clic en el botón «Save» [Guardar]. Se puede 

visualizar la reconstrucción en la aplicación Hybrid Viewer haciendo clic en el botón «Hybrid 

Viewer» [Hybrid Viewer]. Esta acción se puede realizar antes o después de guardar. 

  

  

3.2.1.5 Página de resultados 
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La sección «Mask» [Máscara] permite enmascarar una parte de las imágenes SPECT con una 

máscara esférica. 

  

Se puede utilizar la herramienta de máscara haciendo clic en el botón de opción «Show sphere» 

[Mostrar esfera]. Una vez que el botón de opción esté activo, una esfera se posicionará 

automáticamente en la posición del píxel más caliente del estudio SPECT. 

  

El tamaño de la esfera de la máscara está controlado por el campo «Sphere diameter [pixel]» 

[Diámetro de la esfera [píxel]]. 

  

La máscara se aplica al SPECT presionando el botón «Mask» [Máscara]. La máscara que se aplica 

se puede eliminar utilizando el botón «Undo» [Deshacer]. 

  

  

 
  

Se puede mover la posición de la máscara esférica en el SPECT haciendo un solo clic en las vistas 

TCS. Se puede desplazar por las vistas individuales de TCS con la rueda del ratón. 

En la pestaña «Recon» [Reconstrucción], se puede elegir el protocolo de reconstrucción con el 

cuadro desplegable en el lado derecho del protocolo de reconstrucción «Primary» [Principal]. 

  

Se pueden realizar reconstrucciones adicionales del mismo estudio. Activar los botones de opción 

«Secondary» [Secundario] y «Tertiary» [Terciario].  Se puede elegir el protocolo de reconstrucción 

de las reconstrucciones adicionales utilizando el cuadro desplegable junto al protocolo de 

reconstrucción secundario y terciario. 

  

3.2.2 Flujo de trabajo de neurología 

3.2.2.1 Página de reconstrucción 



Hybrid Recon 5.0.0   16 (54) 

P21-027 Instrucciones de uso de Hybrid Recon 5.0.0 Rev.2_SP 

Número del documento> 

 
  

Al arrastrar las líneas horizontales hacia arriba y hacia abajo en la imagen de cine, se cambiará el 

tamaño del campo de reconstrucción. 

  

 
  

La imagen del cine de las proyecciones de SPECT se puede iniciar, detener, mover hacia adelante, 

hacia atrás o en reversa, utilizando los botones multimedia «Play» [Reproducir], «Stop» [Detener], 
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etc. Se puede evaluar cualquier movimiento en la proyección consultando las imágenes 

«Sinogram» [Sinograma] y «Linogram» [Linograma]. 

  

 
  

La pestaña «Moco» [Corrección de movimiento] permite realizar la corrección de movimiento del 

estudio SPECT. Hay tres tipos de corrección de movimiento que están disponibles: «Auto (y-only)» 

[Automático (solo y)], «Auto (x and y)» [Automático (x e y)] y «Man» [Manual]. Con los botones de 

opción, se puede cambiar el tipo de corrección de movimiento. 

  

 
  

La sección «Auto» [Automático] estará disponible si se selecciona un tipo de corrección de 

movimiento automático. El botón «Start» [Iniciar] permite realizar una corrección de movimiento 

automática. El botón «Undo» [Deshacer] restaura las proyecciones originales después de aplicar 

la corrección de movimiento. El botón «Show» [Mostrar] permite mostrar la ventana «MoCo» 

[Corrección de movimiento]. Cuando no se ha aplicado ninguna corrección de movimiento, este 

botón aparece en gris. 

  

 
  

Presionar «Start» [Iniciar] para iniciar una corrección de movimiento automatizada. Aparecerá 

una ventana «HybridRecon-MoCo» [HybridRecon-Corrección de movimiento] cuando finalice la 

corrección de movimiento. En esta ventana se mostrará una representación visual de los cambios 

de corrección de movimiento que se realicen en la proyección MoCo (corrección de movimiento). 

Se pueden comparar las proyecciones originales con las proyecciones SPECT MoCo con los 

botones multimedia. 

  

El botón «Screen Capture» [Captura de pantalla] permite guardar una captura de pantalla de la 

ventana de MoCo. Pulsar la cruz en la parte superior derecha de esa ventana para cerrar la 

ventana de MoCo. 
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La sección «Man» [Manual] estará disponible si el «Moco type» [Tipo de corrección de 

movimiento] está configurado en manual («Man» [Manual]). La proyección se puede mover 

usando las flechas. Si el botón de opción «One frame only» [Un solo fotograma] está activado, el 

cambio se aplicará solo a un fotograma. Se pueden utilizar los botones multimedia, los controles 

deslizantes o la rueda del ratón (si el cursor está sobre la imagen de cine) para cambiar la 

proyección. 

  

Se puede seleccionar un rango de proyecciones para mover de forma manual utilizando los 

campos «From frame» [Desde fotograma] y «To frame» [Hasta el fotograma]. 

  

 
  

Se puede guardar una copia de las proyecciones corregidas por movimiento haciendo clic en el 

botón «Save» [Guardar]. El botón «Screen Capture» [Captura de pantalla] guarda una captura de 

pantalla de las imágenes de cine, sinograma y linograma. 
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La herramienta «Moco» [Corrección de movimiento] aparece en gris si se ha cargado una 

adquisición SPECT de múltiples posiciones. 

  

La pestaña «Noise» [Ruido] permite agregar ruido de disparo a la proyección. 

  

 
  

Si se utiliza un mapa de atenuación uniforme para realizar la corrección de atenuación, se 

mostrará una página del mapa de atenuación uniforme. 

  

En la sección «Display» [Pantalla], el campo «Zoom» [Zoom] permite modificar el factor de Zoom 

de la vista de inicio que se muestra. 

  

 
  

En la sección «Outline» [Contorno], se puede cambiar la configuración del mapa uniforme 

utilizando los campos «Outline threshold [%]» [Umbral de contorno [%]] y «Outline filter FWHM 

[cm]» [Filtro de contorno FWHM [cm]]. El botón «Trace» [Trazar] establecerá el contorno del 

mapa de atenuación uniforme, en función de la información que se proporciona en los campos 

anteriores. El botón de opción «Link outlines» [Enlazar contornos] permite mover el contorno 

uniforme del mapa de atenuación simultáneamente en cada corte. 

  

El proceso de reconstrucción continuará una vez que se haga el clic en el botón «Continue 

reconstruction» [Continuar reconstrucción]. El botón «Screen capture» [Captura de pantalla] 

generará una captura de pantalla de la vista de inicio del mapa de atenuación uniforme. 

  

 

3.2.2.2 Página de contorno del mapa de atenuación (mu-map) uniforme 
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En la página de registro conjunto, se puede realizar un control de calidad de alineación de SPECT-

CT. 

  

En la sección «Display» [Pantalla], el campo «Zoom» [Zoom] permite aplicar un factor de Zoom 

específico a las vistas de fusión transversal, coronal y sagital. Cuando el botón de opción 

«Triangulate» [Triangular] está activo, se puede triangular en las vistas TCS con un solo clic 

izquierdo en cualquier vista. 

  

 
  

En la sección «Transformation» [Transformación], se puede elegir entre tres técnicas de 

alineación diferentes: 

  

• «Automatic full 6 parameter» [Automático completo de 6 parámetros] permite realizar un 

registro conjunto de forma automática de los ejes X, Y, Z y las rotaciones. 

• «Automatic translation only» [Solo traducción automática] permite realizar un registro 

conjunto de forma automática de los ejes X, Y y Z. 

• «Manual» [Manual] permite realizar un registro conjunto de forma manual. 

  

 
  

En la sección «Transformation parameters» [Parámetros de transformación] se mostrarán los 

valores del movimiento del registro conjunto en los campos «X-shift» [Cambio X], «Y-shift» 

[Cambio Y], «Z-shift» [Cambio Z], «Transverse rotations» [Rotaciones transversales], «Coronal 

rotation» [Rotación coronal] y «Sagittal rotation» [Rotación sagital]. 

  

El botón «Apply» [Aplicar] realizará los cambios de registro conjunto. Si se activa un tipo de 

transformación automática, al hacer clic en «Apply» [Aplicar] se realizarán los cambios del 

registro conjunto de forma automática. Si se activa el tipo de transformación «Manual» [Manual], 

será necesario introducir de forma manual los valores en los campos «Transformation 

parameters» [Parámetros de transformación] para permitir los cambios. 

  

Los cambios del registro conjunto se pueden deshacer utilizando el botón «Undo» [Deshacer]. 

  

3.2.2.3 Página de registro conjunto SPECT-CT 
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Cuando «Transformation type» [Tipo de transformación] se configura en manual, se puede 

arrastrar la CT sobre las imágenes SPECT moviendo el ratón sobre las vistas TCS. 

  

El botón «Screen capture» [Captura de pantalla] permite guardar una captura de pantalla de la 

imagen de los cambios del registro conjunto. Si la opción «Save mumap» [Guardar mapa de 

atenuación] está habilitada, el botón estará activo y permitirá guardar una copia del mapa de 

atenuación. El botón «Continue reconstruction» [Continuar reconstrucción] permite continuar el 

proceso de reconstrucción. 

  

 
  

El menú desplegable «Color Table» [Tabla de colores] en la sección «Emission study colors» 

[Colores del estudio de emisión] permite cambiar la paleta de colores SPECT. Los límites de 

umbral inferior y superior se pueden cambiar utilizando los controles deslizantes «LT» [Umbral 

inferior] y «UT» [Umbral superior]. 

  

Los controles deslizantes «Level» [Nivel] y «Window» [Ventana] en la sección «Transmission study 

colors» [Colores del estudio de transmisión] permiten cambiar la ventana de CT. El control 

deslizante «Alpha» [Alfa] permite realizar una transición gradual entre el SPECT en el extremo 

izquierdo y el CT en el extremo derecho. 
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Hay una opción para omitir esta página. 

  

En la página de filtro, se puede cambiar el filtro aplicado a un SPECT reconstruido. 

  

Se puede seleccionar el conjunto de datos en el que se quiera aplicar el filtro utilizando el menú 

desplegable «Dataset» [Conjunto de datos] en la sección «data» [datos]. 

  

En la sección «Display» [Pantalla], el campo «Zoom» [Zoom] permite elegir el Zoom aplicado en la 

vista de pantalla de inicio de la derecha. Los botones de opción «Trans» [Transversal], «Coro» 

[Coronal], «Sag» [Sagital] y «TCS» [TCS] permiten elegir qué vista(s) se mostrará(n) en el área de 

inicio derecha. 

  

En la sección «Filter» [Filtro], se puede cambiar el tipo de filtro. Hay cuatro tipos disponibles: 

«Gaussiano», «Butterworth», «Hanning» y «Hamming». Los campos «FWHM [cm]» [Anchura a 

media altura FWHM [cm]], «Cutoff [1/cm]» [Corte [1/cm]] y «Order» [Orden] están disponibles y 

se pueden modificar si es necesario. Los campos disponibles se modificarán según el tipo de 

filtro. 

  

El botón «Apply» [Aplicar] aplicará los cambios del filtro que estén personalizados al conjunto de 

datos SPECT. 

  

3.2.2.4 Página de filtro 
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Se puede volver a alinear las vistas TCS de SPECT en la página de alineación. 

  

En la sección «Mode» [Modo], se puede alternar entre los botones de opción «Align» [Alinear] y 

«Zoom» [Zoom]. 

  

 
  

En el modo «Align» [Alinear], se mostrarán cruces punteadas sobre las vistas de TCS. Se puede 

mover la cruz sobre el SPECT utilizando el ratón. Cada una de las vistas TCS se triangulará 

automáticamente sobre la nueva ubicación de la cruz. Hay dos opciones disponibles para rotar 

las vistas: deslizar el ratón hasta el ángulo que se requiere en la escala debajo de las vistas TCS o 

cambiar el valor en el campo de escala derecho. Para modificar un valor, hay que escribirlo o usar 

las flechas hacia arriba y hacia abajo. 

  

3.2.2.5 Página de alineación 
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En la sección «Display» [Pantalla], el campo «Zoom» [Zoom] permite elegir el factor de aumento 

que se aplica en la vista de pantalla de inicio de la derecha. Los botones de opción «Trans» 

[Transversal], «Coro» [Coronal], «Sag» [Sagital] y «TCS» [TCS] permiten elegir qué vista(s) se 

mostrará(n) en la sección de inicio de la derecha. 

  

Los botones de opción «1st dataset» [1.er conjunto de datos], «2nd dataset» [2.º conjunto de 

datos] y «3rd dataset» [3.er conjunto de datos] permiten elegir qué serie se mostrará en la sección 

de inicio de la derecha. 

  

 
  

En la sección «Save» [Guardar], se puede introducir una etiqueta en los campos «1st label» [1.ª 

etiqueta], «2nd label» [2.ª etiqueta] y «3rd label» [3.ª etiqueta]. Después de guardar, este texto se 

agregará a la etiqueta correspondiente de la serie SPECT. 

  

Se pueden guardar las reconstrucciones haciendo clic en el botón «Save» [Guardar]. Se puede 

visualizar la reconstrucción en la aplicación Hybrid Viewer haciendo clic en el botón «Hybrid 

Viewer» [Hybrid Viewer]. Esta acción se puede realizar antes o después de guardar. 

  

3.2.2.6 Página de resultados 
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La sección «Mask» [Máscara] permite enmascarar una parte de las imágenes SPECT con una 

máscara esférica. 

  

Se puede utilizar la herramienta de máscara haciendo clic en el botón de opción «Show sphere» 

[Mostrar esfera]. Una vez que el botón de opción esté activo, una esfera se posicionará 

automáticamente en la posición del píxel más caliente del estudio SPECT. 

  

El tamaño de la esfera de la máscara está controlado por el campo «Sphere diameter [pixel]» 

[Diámetro de la esfera [píxel]]. 

  

La máscara se aplica al SPECT presionando el botón «Mask» [Máscara]. La máscara que se aplica 

se puede eliminar utilizando el botón «Undo» [Deshacer]. 

  

 
  

Se puede mover la posición de la máscara esférica en el SPECT haciendo un solo clic en las vistas 

TCS. Se puede desplazar por las vistas individuales de TCS con la rueda del ratón.  

En la pestaña «Recon» [Reconstrucción], se puede realizar la reconstrucción de hasta dos 

estudios diferentes. Se puede elegir el protocolo de reconstrucción utilizando el cuadro 

desplegable que se encuentra en el lado derecho de cada cuadro de protocolo de reconstrucción 

«Primary» [Principal]. 

  

3.2.3 Flujo de trabajo de pulmón 

3.2.3.1 Página de reconstrucción 
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Para forzar que los campos de reconstrucción se enlacen entre estudios, hay que hacer clic en el 

botón de opción «Link reconstruction limits with Study 1» [Enlazar límites de reconstrucción con 

el estudio 1]. 

  

Al arrastrar las líneas horizontales hacia arriba y hacia abajo en la imagen de cine, se cambiará el 

tamaño del campo de reconstrucción. 

  

 
La imagen del cine de las proyecciones de SPECT se puede iniciar, detener, mover hacia adelante, 

hacia atrás o en reversa, utilizando los botones multimedia «Play» [Reproducir], «Stop» [Detener], 



Hybrid Recon 5.0.0   27 (54) 

P21-027 Instrucciones de uso de Hybrid Recon 5.0.0 Rev.2_SP 

Número del documento> 

etc. Se puede evaluar cualquier movimiento en la proyección consultando las imágenes 

«Sinogram» [Sinograma] y «Linogram» [Linograma]. 

  

 
  

La pestaña «Moco» [Corrección de movimiento] permite realizar la corrección de movimiento del 

estudio SPECT. Hay tres tipos de corrección de movimiento que están disponibles: «Auto (y-only)» 

[Automático (solo y)], «Auto (x and y)» [Automático (x e y)] y «Man» [Manual]. Con los botones de 

opción, se puede cambiar el tipo de corrección de movimiento. 

  

 
  

La sección «Auto» [Automático] estará disponible si se selecciona un tipo de corrección de 

movimiento automático. El botón «Start» [Iniciar] permite realizar una corrección de movimiento 

automática. El botón «Undo» [Deshacer] restaura las proyecciones originales. El botón «Show» 

[Mostrar] permite mostrar la ventana «MoCo» [Corrección de movimiento]. Cuando no se ha 

aplicado ninguna corrección de movimiento, este botón aparece en gris. 

  

 
  

La corrección de movimiento se puede realizar solo en un estudio a la vez. El estudio que tiene la 

etiqueta de serie coloreada en naranja es el activo. 
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\ 

  

Un solo clic sobre el segundo estudio cambiará el estudio que está seleccionado. 

  

Presionar «Start» [Iniciar] para iniciar una corrección de movimiento automatizada. Aparecerá 

una ventana «HybridRecon-MoCo» [HybridRecon-Corrección de movimiento] cuando finalice la 

corrección de movimiento. En esta ventana se mostrará una representación visual de los cambios 

de corrección de movimiento que se realicen en la proyección MoCo (corrección de movimiento). 

Se pueden comparar las proyecciones originales con las proyecciones SPECT MoCo con los 

botones multimedia. 

  

El botón «Screen Capture» [Captura de pantalla] permite guardar una captura de pantalla de la 

ventana de MoCo. Pulsar la cruz en la parte superior derecha de esa ventana para cerrar la 

ventana de MoCo. 
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La sección «Man» [Manual] estará disponible si el «Moco type» [Tipo de corrección de 

movimiento] está configurado en manual («Man» [Manual]). La proyección se puede mover 

usando las flechas. Si el botón de opción «One frame only» [Un solo fotograma] está activado, el 

cambio se aplicará solo a un fotograma. Se pueden utilizar los botones multimedia, los controles 

deslizantes o la rueda del ratón (si el cursor está sobre la imagen de cine) para cambiar la 

proyección. 

  

Se puede seleccionar un rango de proyecciones para mover de forma manual utilizando los 

campos «From frame» [Desde fotograma] y «To frame» [Hasta el fotograma]. 

  

 
  

Se puede guardar una copia de las proyecciones corregidas por movimiento haciendo clic en el 

botón «Save» [Guardar]. El botón «Screen Capture» [Captura de pantalla] guarda una captura de 

pantalla de las imágenes de cine, sinograma y linograma. 
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La herramienta «Moco» [Corrección de movimiento] aparece en gris si se ha cargado una 

adquisición SPECT de múltiples posiciones. 

  

La pestaña «Noise» [Ruido] permite agregar ruido de disparo a la proyección. 

  

 
  

En la página de registro conjunto, se puede realizar un control de calidad de alineación de SPECT-

CT o el mapa de atenuación sintético. 

En la sección «Display» [Pantalla], el campo «Zoom» [Zoom] permite aplicar un factor de Zoom 

específico a las vistas de fusión transversal, coronal y sagital. Cuando el botón de opción 

«Triangulate» [Triangular] está activo, se puede triangular en las vistas TCS con un solo clic 

izquierdo en cualquier vista. 

  

 
  

En la sección «Transformation» [Transformación], se puede elegir entre tres técnicas de 

alineación diferentes: 

  

• «Automatic full 6 parameter» [Automático completo de 6 parámetros] permite realizar un 

registro conjunto de forma automática de los ejes X, Y, Z y las rotaciones. 

• «Automatic translation only» [Solo traducción automática] permite realizar un registro 

conjunto de forma automática de los ejes X, Y y Z. 

• «Manual» [Manual] permite realizar un registro conjunto de forma manual. 

 
  

En la sección «Transformation parameters» [Parámetros de transformación] se mostrarán los 

valores del movimiento del registro conjunto en los campos «X-shift» [Cambio X], «Y-shift» 

[Cambio Y], «Z-shift» [Cambio Z], «Transverse rotations» [Rotaciones transversales], «Coronal 

rotation» [Rotación coronal] y «Sagittal rotation» [Rotación sagital]. 

  

3.2.3.2 Página de registro conjunto de SPECT-CT o mapa de atenuación 
sintético 
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El botón «Apply» [Aplicar] realizará los cambios de registro conjunto. Si se activa un tipo de 

transformación automática, al hacer clic en «Apply» [Aplicar] se realizarán los cambios del 

registro conjunto de forma automática. Si se activa el tipo de transformación «Manual» [Manual], 

será necesario introducir de forma manual los valores en los campos «Transformation 

parameters» [Parámetros de transformación] para permitir los cambios. 

  

Los cambios del registro conjunto se pueden deshacer utilizando el botón «Undo» [Deshacer]. 

  

 
  

Cuando «Transformation type» [Tipo de transformación] se configura en manual, se puede 

arrastrar CT sobre las imágenes SPECT moviendo el ratón sobre las vistas TCS (transversal, 

coronal y sagital). 

  

El botón «Screen capture» [Captura de pantalla] permite guardar una captura de pantalla de la 

imagen de los cambios del registro conjunto. Si la opción «Save mumap» [Guardar mapa de 

atenuación] está habilitada, el botón estará activo y permitirá guardar una copia del mapa de 

atenuación. El botón «Continue reconstruction» [Continuar reconstrucción] permite continuar el 

proceso de reconstrucción. 

  

 
  

El menú desplegable «Color Table» [Tabla de colores] en la sección «Emission study colors» 

[Colores del estudio de emisión] permite cambiar la paleta de colores SPECT. Los límites de 

umbral inferior y superior se pueden cambiar utilizando los controles deslizantes «LT» [Umbral 

inferior] y «UT» [Umbral superior]. 

  

Los controles deslizantes «Level» [Nivel] y «Window» [Ventana] en la sección «Transmission study 

colors» [Colores del estudio de transmisión] permiten cambiar la ventana de CT. El control 

deslizante «Alpha» [Alfa] permite realizar una transición gradual entre el SPECT en el extremo 

izquierdo y el CT en el extremo derecho. 
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En la página de filtro, se puede cambiar el filtro aplicado a un SPECT reconstruido. 

  

Se puede seleccionar el conjunto de datos en el que se quiera aplicar el filtro utilizando el menú 

desplegable «Dataset» [Conjunto de datos] en la sección «data» [datos]. 

  

En la sección «Display» [Pantalla], el campo «Zoom» [Zoom] permite elegir el Zoom aplicado en la 

vista de pantalla de inicio de la derecha. Los botones de opción «Trans» [Transversal], «Coro» 

[Coronal], «Sag» [Sagital] y «TCS» [TCS] permiten elegir qué vista(s) se mostrará(n) en el área de 

inicio derecha. 

  

En la sección «Filter» [Filtro], se puede cambiar el tipo de filtro. Hay cuatro tipos disponibles: 

«Gaussiano», «Butterworth», «Hanning» y «Hamming». Los campos «FWHM [cm]» [Anchura a 

media altura FWHM [cm]], «Cutoff [1/cm]» [Corte [1/cm]] y «Order» [Orden] están disponibles y 

se pueden modificar si es necesario. Los campos disponibles se modificarán según el tipo de 

filtro. 

  

El botón «Apply» [Aplicar] aplicará los cambios del filtro que estén personalizados al conjunto de 

datos SPECT. 

  

3.2.3.3 Página de filtro 
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Esta página está destinada a generar imágenes estáticas/WB de reproyección desde el AC 

SPECT. 

  

En la sección «Protocol» [Protocolo], el menú desplegable «Protocol» [Protocolo] permite elegir 

entre diferentes protocolos de reproyección. Al hacer clic en el botón «Show Parameters» [Mostrar 

parámetros], se abrirá una ventana «Reprojection parameters» [Parámetros de reproyección] que 

permitirá ver qué ajustes de reproyección están configuradas para ese protocolo. 

Las reproyecciones se generarán al hacer clic en el botón «Perform re-projection» [Realizar 

reproyección]. Las reproyecciones que se generan se pueden eliminar haciendo clic en el botón 

«Undo re-projection» [Deshacer reproyección]. 

  

 

En la sección «Display» [Pantalla], el campo «Zoom» [Zoom] permite elegir el factor de aumento 

que se aplica en la vista de pantalla de inicio de la derecha. Los botones de opción «Trans» 

[Transversal], «Coro» [Coronal], «Sag» [Sagital] y «TCS» [TCS] permiten elegir qué vista(s) se 

mostrará(n) en la sección de inicio de la derecha. 

3.2.3.4 Página de reproyección 

3.2.3.5 Página de resultados 
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Los botones de opción «1st dataset» [1.er conjunto de datos] y «2nd dataset» [2.º conjunto de 

datos] permiten elegir qué serie se mostrará en la sección de inicio de la derecha. 

  

 
  

En la sección «Save» [Guardar], se puede introducir una etiqueta en los campos «1st label» [1.ª 

etiqueta] y «2nd label» [2.ª etiqueta]. Después de guardar, este texto se agregará a la etiqueta 

correspondiente de la serie SPECT. 

  

Se pueden guardar las reconstrucciones haciendo clic en el botón «Save» [Guardar]. Se puede 

visualizar la reconstrucción en la aplicación Hybrid Viewer haciendo clic en el botón «Hybrid 

Viewer» [Hybrid Viewer]. Esta acción se puede realizar antes o después de guardar. 

  

 
  

La sección «Mask» [Máscara] permite enmascarar una parte de las imágenes SPECT con una 

máscara esférica. 

  

Se puede utilizar la herramienta de máscara haciendo clic en el botón de opción «Show sphere» 

[Mostrar esfera]. Una vez que el botón de opción esté activo, una esfera se posicionará 

automáticamente en la posición del píxel más caliente del estudio SPECT. 

  

El tamaño de la esfera de la máscara está controlado por el campo «Sphere diameter [pixel]» 

[Diámetro de la esfera [píxel]]. 

  

La máscara se aplica al SPECT presionando el botón «Mask» [Máscara]. La máscara que se aplica 

se puede eliminar utilizando el botón «Undo» [Deshacer]. 

  

 
  

Se puede mover la posición de la máscara esférica en el SPECT haciendo un solo clic en las vistas 

TCS. Se puede desplazar por las vistas individuales de TCS con la rueda del ratón. 
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En la pestaña «Recon» [Reconstrucción], se puede realizar la reconstrucción de hasta tres 

estudios diferentes. Se puede elegir el protocolo de reconstrucción utilizando el cuadro 

desplegable que se encuentra en el lado derecho de cada cuadro de protocolo de reconstrucción 

«Non-gated» [No gatillado] «Gated» [Gatillado]. Si no se han cargado estudios gatillados de 

SPECT en la aplicación, los cuadros «Gated» [Gatillado] aparecen en gris. 

  

Si el botón de opción «2nd NG» [2.º No gatillado] está activo, las casillas «2nd Non-gated» [2.º No 

gatillado] estarán disponibles. Se puede elegir el protocolo de reconstrucción utilizando el menú 

desplegable que se encuentra en el lado derecho de estos cuadros. 

  

El uso de corrección de atenuación está disponible solo para los primeros cuadros «Non-gated» 

[No gatillados].   

  

 
  

Al arrastrar las líneas horizontales hacia arriba y hacia abajo en la imagen de cine, se cambiará el 

tamaño del campo de reconstrucción. 

  

3.2.4 Flujo de trabajo de cardiología 

3.2.4.1 Página de reconstrucción 
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La cruz circular debe estar centrada en el medio del miocardio en las vistas anterior y lateral para 

estudios cardíacos de estrés/reposo y centrada en la posición del ventrículo izquierdo para los 

estudios SPECT de la acumulación de sangre. 

  
Estudio cardíaco en estrés y reposo 
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Estudio de acumulación de sangre 

   

 
   

La imagen del cine de las proyecciones de SPECT se puede iniciar, detener, mover hacia adelante, 

hacia atrás o en reversa, utilizando los botones multimedia «Play» [Reproducir], «Stop» [Detener], 

etc. Se puede evaluar cualquier movimiento en la proyección consultando las imágenes 

«Sinogram» [Sinograma] y «Linogram» [Linograma]. 

   

 
   

La pestaña «Moco» [Corrección de movimiento] permite realizar la corrección de movimiento del 

estudio SPECT. Hay tres tipos de corrección de movimiento que están disponibles: «Auto (y-only)» 

[Automático (solo y)], «Auto (x and y)» [Automático (x e y)] y «Man» [Manual]. Con los botones de 

opción, se puede cambiar el tipo de corrección de movimiento. 

  

 
  

La sección «Auto» [Automático] estará disponible si se selecciona un tipo de corrección de 

movimiento automático. El botón «Start» [Iniciar] permite realizar una corrección de movimiento 

automática. El botón «Undo» [Deshacer] restaura las proyecciones originales. El botón «Show» 

[Mostrar] permite mostrar la ventana «MoCo» [Corrección de movimiento]. Cuando no se ha 

aplicado ninguna corrección de movimiento, este botón aparece en gris. 
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La corrección de movimiento se puede realizar solo en un estudio a la vez. El estudio que tiene la 

etiqueta de serie coloreada en naranja es el activo. 

  

 
  

Un solo clic sobre el otro estudio cambiará el estudio que está seleccionado. 
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Presionar «Start» [Iniciar] para iniciar una corrección de movimiento automatizada. Aparecerá 

una ventana «HybridRecon-MoCo» [HybridRecon-Corrección de movimiento] cuando finalice la 

corrección de movimiento. En esta ventana se mostrará una representación visual de los cambios 

de corrección de movimiento que se realicen en la proyección MoCo (corrección de movimiento). 

Se pueden comparar las proyecciones originales con las proyecciones SPECT MoCo con los 

botones multimedia. 

  

El botón «Screen Capture» [Captura de pantalla] permite guardar una captura de pantalla de la 

ventana de MoCo. Pulsar la cruz en la parte superior derecha de esa ventana para cerrar la 

ventana de MoCo. 

  

 
  

La sección «Man» [Manual] estará disponible si el «Moco type» [Tipo de corrección de 

movimiento] está configurado en manual («Man» [Manual]). La proyección se puede mover 

usando las flechas. Si el botón de opción «One frame only» [Un solo fotograma] está activado, el 

cambio se aplicará solo a un fotograma. Se pueden utilizar los botones multimedia, los controles 

deslizantes o la rueda del ratón (si el cursor está sobre la imagen de cine) para cambiar la 

proyección. 

  

Se puede seleccionar un rango de proyecciones para mover de forma manual utilizando los 

campos «From frame» [Desde fotograma] y «To frame» [Hasta el fotograma]. 
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Se puede guardar una copia de las proyecciones corregidas por movimiento haciendo clic en el 

botón «Save» [Guardar]. El botón «Screen Capture» [Captura de pantalla] guarda una captura de 

pantalla de las imágenes de cine, sinograma y linograma. 

  

La herramienta «Moco» [Corrección de movimiento] aparece en gris si se ha cargado una 

adquisición SPECT de múltiples posiciones. 

  

La pestaña «Noise» [Ruido] permite agregar ruido de disparo a la proyección. 

  

 

En la página de alineación se puede cambiar la orientación de los estudios. 

  

Los botones de opción «Link studies» [Enlazar estudios] vincularán la orientación de los estudios. 

Se puede desactivar la máscara activando el botón de opción «Disable masking» [Desactivar 

máscara]. 

  

Se puede continuar el proceso de reconstrucción haciendo clic en el botón «Continue» 

[Continuar]. 

  

 
  

3.2.4.2 Página de alineación 
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Para rotar las vistas VLA (vista lateral anterior) y HLA (vista lateral posterior), se puede arrastrar 

el cursor en la escala horizontal debajo de las vistas o modificar el valor en el cuadro de 

angulación con el teclado o las flechas arriba y abajo. 

  

 
  

Cuando se pase el cursor sobre una vista, se puede desplazar por las cortes con la rueda del 

ratón. 

  

Se puede cambiar la triangulación de las vistas arrastrando el centro de la cruz circular. Se 

recomienda ubicar el centro de la cruz circular en el centro del miocardio o, para estudios de 

acumulación de sangre, en el centro del ventrículo izquierdo. 

  

Para ayudar a orientar visualmente las vistas VLA y HLA, se muestra un pequeño símbolo 

cardíaco debajo de cada vista. Para los estudios de acumulación de sangre, se puede consultar la 

posición del ápice del símbolo cardíaco para encontrar la orientación más adecuada para las 

vistas. 

  

  
Estudio de estrés y reposo 

  

 
  
Estudio de acumulación de sangre 
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En la página de registro conjunto, se puede realizar un control de calidad de alineación de SPECT-

CT o el mapa de atenuación sintético. 

  

En la sección «Display» [Pantalla], el campo «Zoom» [Zoom] permite aplicar un factor de Zoom 

específico a las vistas de fusión transversal, coronal y sagital. Cuando el botón de opción 

«Triangulate» [Triangular] está activo, se puede triangular en las vistas TCS con un solo clic 

izquierdo en cualquier vista. 

  

 
  

En la sección «Transformation» [Transformación], se puede elegir entre tres técnicas de 

alineación diferentes: 

  

• «Automatic full 6 parameter» [Automático completo de 6 parámetros] permite realizar un 

registro conjunto de forma automática de los ejes X, Y, Z y las rotaciones. 

• «Automatic translation only» [Solo traducción automática] permite realizar un registro 

conjunto de forma automática de los ejes X, Y y Z. 

• «Manual» [Manual] permite realizar un registro conjunto de forma manual. 

  

 
  

En la sección «Transformation parameters» [Parámetros de transformación] se mostrarán los 

valores del movimiento del registro conjunto en los campos «X-shift» [Cambio X], «Y-shift» 

[Cambio Y], «Z-shift» [Cambio Z], «Transverse rotations» [Rotaciones transversales], «Coronal 

rotation» [Rotación coronal] y «Sagittal rotation» [Rotación sagital]. 

  

El botón «Apply» [Aplicar] realizará los cambios de registro conjunto. Si se activa un tipo de 

transformación automática, al hacer clic en «Apply» [Aplicar] se realizarán los cambios del 

registro conjunto de forma automática. Si se activa el tipo de transformación «Manual» [Manual], 

será necesario introducir de forma manual los valores en los campos «Transformation 

parameters» [Parámetros de transformación] para permitir los cambios. 

  

Los cambios del registro conjunto se pueden deshacer utilizando el botón «Undo» [Deshacer]. 

  

3.2.4.3 Página de registro conjunto de SPECT-CT o mapa de atenuación 
sintético 
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Cuando «Transformation type» [Tipo de transformación] se configura en manual, se puede 

arrastrar CT sobre las imágenes SPECT moviendo el ratón sobre las vistas TCS (transversal, 

coronal y sagital). 

  

El botón «Screen capture» [Captura de pantalla] permite guardar una captura de pantalla de la 

imagen de los cambios del registro conjunto. Si la opción «Save mumap» [Guardar mapa de 

atenuación] está habilitada, el botón estará activo y permitirá guardar una copia del mapa de 

atenuación. El botón «Continue reconstruction» [Continuar reconstrucción] permite continuar el 

proceso de reconstrucción. 

  

 
  

El menú desplegable «Color Table» [Tabla de colores] en la sección «Emission study colors» 

[Colores del estudio de emisión] permite cambiar la paleta de colores SPECT. Los límites de 

umbral inferior y superior se pueden cambiar utilizando los controles deslizantes «LT» [Umbral 

inferior] y «UT» [Umbral superior]. 

  

Los controles deslizantes «Level» [Nivel] y «Window» [Ventana] en la sección «Transmission study 

colors» [Colores del estudio de transmisión] permiten cambiar la ventana de CT.  El control 

deslizante «Alpha» [Alfa] permite realizar una transición gradual entre el SPECT en el extremo 

izquierdo y el CT en el extremo derecho. 
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Hay una opción para omitir esta página. 

  

En la página de filtro, se puede cambiar el filtro aplicado a un SPECT reconstruido. 

  

Se puede seleccionar el conjunto de datos en el que se quiera aplicar el filtro utilizando el menú 

desplegable «Dataset» [Conjunto de datos] en la sección «data» [datos]. 

  

En la sección «Display» [Pantalla], el campo «Zoom» [Zoom] permite elegir el Zoom aplicado en la 

vista de pantalla de inicio. Los botones de opción «Trans» [Transversal], «Coro» [Coronal], «Sag» 

[Sagital] y «TCS» [TCS] permiten elegir qué vista(s) se mostrará(n) en el área de inicio derecha. 

  

En la sección «Filter» [Filtro], se puede cambiar el tipo de filtro. Hay cuatro tipos disponibles: 

«Gaussiano», «Butterworth», «Hanning» y «Hamming»Los campos «FWHM [cm]» [Anchura a media 

altura FWHM [cm]], «Cutoff [1/cm]» [Corte [1/cm]] y «Order» [Orden] están disponibles y se 

pueden modificar si es necesario. Los campos disponibles se modificarán según el tipo de filtro. 

  

El botón «Apply» [Aplicar] aplicará los cambios del filtro que estén personalizados al conjunto de 

datos SPECT. 

  

3.2.4.4 Página de filtro 
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En la sección «Display» [Pantalla], los botones de opción «HLA» [Vista lateral posterior], «SA» 

[Vista superior] y «VLA» [Vista lateral anterior] permiten elegir qué vista(s) se mostrará(n) en la 

sección de presentación. 

Los menús desplegables «1st study gate» [1.er estudio gatillado], «2nd study gate» [2.º estudio 

gatillado] y «3rd study gate» [3.er studio gatillado] permiten elegir qué cuadro del SPECT gatillado 

se mostrará en la sección de presentación. 

  

 
  

En la sección «Labels» [Etiquetas], se puede introducir una etiqueta en los campos «1st label» [1.ª 

etiqueta], «2nd label» [2.ª etiqueta] y «3rd label» [3.ª etiqueta]. Después de guardar, este texto se 

agregará a la etiqueta correspondiente de la serie SPECT. 

  

En la sección «Coronal» [Coronal], el botón «Save coronal» [Guardar coronal] activará el guardado 

de las vistas coronales. Si el estudio es un estudio de situs inversus o dextrocardia, el botón de 

alternancia «Dextrocardia» [Dextrocardia] invertirá las vistas del corazón. 

  

3.2.4.5 Página de resultados 
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Se puede aplicar un factor de Zoom a las vistas coronales guardadas haciendo clic en el botón de 

opción «Save with zoom» [Guardar con Zoom] en la sección «Zoom» [Zoom]. La opción «Save 

without zoom» [Guardar sin Zoom] desactivará el factor Zoom.  

  

Se puede ajustar el factor de Zoom, modificando el valor del cuadro «Saved zoom [%]» [Zoom 

guardado [%]]. Para cambiar ese valor, se debe utilizar el teclado o las flechas arriba y abajo. 

  

La sección «Gated only» [Solo gatillado] permite guardar solo la serie gatillada. Esta opción está 

disponible si se carga un estudio de acumulación de sangre. En otros casos, la opción aparecerá 

inactiva. 

  

Se pueden guardar las vistas transversales activando o desactivando los botones de opción «Non-

gated» [No gatillado] y [Gatillado] en la sección «Transverse» [Transversal]. 

  

El botón «Save» [Guardar] permite guardar las vistas especificadas en las secciones «Coronal» 

[Coronal] y «Transverse» [Transversal] anteriores. Se puede visualizar la reconstrucción en la 

aplicación Hybrid Viewer haciendo clic en el botón «Hybrid Viewer» [Hybrid Viewer]. Esta acción 

se puede realizar antes o después de guardar. 

  

 

Se pueden abrir los parámetros avanzados de la aplicación haciendo clic en el icono de lista 

«Program Parameters» [Parámetros del programa] en la parte superior derecha de la ventana de 

la aplicación. 

  

 
  

Se abrirá una ventana de «program parameters» [parámetros del programa] que dará acceso a 

los parámetros configurados. Los manuales de cada flujo de trabajo específico proporcionan más 

detalles sobre las configuraciones avanzadas y sus efectos. 

  

3.3 Interfaz 
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Al hacer clic en el símbolo de «question mark» [signo de interrogación], se iniciará el manual de 

Hybrid Recon específico para ese flujo de trabajo específico. 

  

 
  

El icono «i» [i] iniciará la aplicación Aboutbox. 

  

 
  

En esa sección, se encuentra información sobre el nombre del producto, la versión de 

lanzamiento, el nombre comercial, la compilación del software, la fecha de fabricación, 

direcciones de correo electrónico, etc. 

Hybrid Viewer 5.0 procesa Información de identificación personal (PII, en inglés), por lo que 

Hermes Medical Solutions trabaja activamente con ciberseguridad durante la fabricación para 

garantizar el más alto nivel de seguridad. Para aumentar aún más la seguridad, el software 

admite las propias medidas de seguridad de los clientes, como, entre otras, el control de acceso y 

autorización, antivirus, actualización del sistema operativo y cifrado de discos. Para más 

información, por favor, contactar a support@hermesmedical.com. 

  

Es responsabilidad del cliente instalar y mantener el software antivirus en el servidor y en los 

ordenadores de los clientes, así como aplicar la protección necesaria contra posibles amenazas. 

  

Procedimientos de copia de seguridad 

• Se crea una copia de seguridad del último archivo de configuración una vez por sesión 

cuando está en modo de usuario o administrador.    

• Se realiza una copia de seguridad de la última configuración la primera vez que el usuario 

realiza algún cambio en la configuración (incluye el flujo de trabajo, el diseño, las reglas, 

etc.).    

• Nunca se crea una copia de seguridad de los valores predeterminados de fábrica.   

• Se almacenarán un máximo de 10 copias y, si se excede el número máximo de copias, se 

eliminará la copia de seguridad más antigua. 

 
  

All studies to be used in this application (SPECT and CT) should be sent to the 

Hermes Medical Solution software directly from the originating scanners. 

Todos los estudios que se utilizarán en esta aplicación (SPECT y CT) se deben enviar al 

software Hermes Medical Solution directamente desde los escáneres de origen. 

 

 
  

When performing quantitative reconstruction (SUV SPECT), the patient 

information, such as weight and height, and the study activity should be checked 

carefully. 

Al realizar una reconstrucción cuantitativa (SUV SPECT), se debe verificar 

cuidadosamente la información del paciente, como el peso y la altura, y la actividad 

del estudio. 

 

 

3.4 Seguridad 

3.5 Advertencias 

mailto:support@hermesmedical.com
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Motion correction should be performed only in cases where it is truly needed. It 

is recommended to compare reconstructed studies produced from the original 

acquisition study and the motion corrected acquisition study. Consideration 

should be given to repeating the scan in cases of severe patient motion. 

La corrección del movimiento se debe realizar solo en los casos en que sea realmente 

necesaria. Se recomienda comparar estudios reconstruidos que se producen a partir 

del estudio de adquisición original y el estudio de adquisición con corrección de 

movimiento. Se debe considerar repetir la exploración en casos de movimiento severo 

del paciente. 

  

 
  

  

  

  

The accuracy of quantification is dependent on several factors such as, but not 

limited to, camera resolution, type of collimator, the energy of the isotope, 

partial volume effect and size of the imaged target. The quantitative accuracy is 

higher with larger targets compared with smaller targets. It is important that the 

accuracy is evaluated based on conducted phantom measurements, to ensure 

the reliability of the quantified values. 

La precisión de la cuantificación depende de varios factores, como, entre otros, la 

resolución de la cámara, el tipo de colimador, la energía del isótopo, el efecto de 

volumen parcial y el tamaño del objetivo fotografiado. La precisión cuantitativa es 

mayor con objetivos más grandes en comparación con objetivos más pequeños. Es 

importante que la precisión se evalúe con base en mediciones de fantoma realizadas, 

para garantizar la confiabilidad de los valores cuantificados.  

 

 
  

  

  

  

  

Decay correct projections: 

• This option is only available when  string matching is enabled 

• This option should be enabled when reconstructing quantitative SPECT 

reconstruction 

• The option to save Motion corrected studies is only available when this is 

enabled 

Proyecciones corregidas por decaimiento: 

• Esta opción solo está disponible cuando la coincidencia de cadenas está 

habilitada. 

• Esta opción debe estar habilitada al reconstruir la reconstrucción SPECT 

cuantitativa. 

• La opción para guardar estudios corregidos por movimiento solo está 

disponible cuando esta opción está habilitada. 

  

 
  

  

  

  

  

  

  

  

When comparing multiple studies from the same patient, it is recommended to 

use either GPU or CPU reconstruction for all studies. Quantitative results using 

GPU and CPU may differ slightly. 

When using reconstructed studies in applications which compare to a database, 

such as Cedars and 4DM for Cardiology and BRASS for Neurology, it is 

recommended to use reconstruction parameters which are as close as possible 

to those used for reconstructing the studies included in the databases. In most 

cases the databases have been created from studies reconstructed with CPU. 

  

Al comparar varios estudios del mismo paciente, se recomienda utilizar la 

reconstrucción por GPU o CPU para todos los estudios. Los resultados cuantitativos 

que utilizan GPU y CPU pueden diferir ligeramente. 

Al utilizar estudios reconstruidos en aplicaciones que se comparan con una base de 

datos, como Cedars y 4DM para cardiología y BRASS para neurología, se recomienda 

utilizar parámetros de reconstrucción que sean lo más cercanos posible a los que se 
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utilizan para reconstruir los estudios que se incluyen en las bases de datos. En la 

mayoría de los casos las bases de datos se han creado a partir de estudios 

reconstruidos con CPU. 

  

 
  

  

  

  

  

  

  

  

  

  

  

  

  

  

Hybrid Recon 5.0 - Neurology 

In order to obtain the most accurate and reproducible results when 

reconstructing studies which will be evaluated using the Hybrid Viewer BRASS 

application for DATScan with the EARL database, the following guidance should 

be followed.  

  

• The ENCDAT reconstruction protocol provided by Hermes Medical 

Solutions should be used. The uniform attenuation outlines should not be 

adjusted, as the slice range reconstructed is set automatically based on 

these outlines. This will ensure the results from BRASS are reproducible. 

The user defined slice limits are not used. 

• The Uniform attenuation outlines should not be adjusted. 

• The reconstructed images should not be aligned manually. 

• The reconstructed images should not be zoomed. 

• If a different reconstruction protocol is used and uniform attenuation 

correction is selected, the ‘Automatic Reconstruction Limits’ option 

should be ticked in the AC page of Reconstruction Parameters. 

Hybrid Recon 5.0 - Neurología 

Para obtener los resultados más precisos y reproducibles al reconstruir estudios que se 

evaluarán utilizando la aplicación Hybrid Viewer BRASS para DATScan con la base de 

datos EARL, se deben seguir las siguientes pautas.  

  

• Se debe utilizar el protocolo de reconstrucción ENCDAT que se proporciona 

por Hermes Medical Solutions. Los contornos de atenuación uniforme no 

deben ajustar, ya que el rango de corte reconstruido se establece 

automáticamente en función de estos contornos. Esto garantizará que los 

resultados de BRASS sean reproducibles. Los límites de corte que se definen 

por el usuario no se utilizan.  

• Los contornos de atenuación uniforme no deben ajustar. 

• Las imágenes reconstruidas no se deben alinear de forma manual. 

• Las imágenes reconstruidas no se deben ampliar. 

• Si se utiliza un protocolo de reconstrucción diferente y se selecciona la 

corrección de atenuación uniforme, se debe marcar la opción «Automatic 

Reconstruction Limits» [Límites de reconstrucción automática] en la página 

AC de Parámetros de reconstrucción. 

  

 
  

Hybrid Recon 5.0 - Neurology 

Rotations and zooming require interpolation, which reduces resolution. Thus 

rotations and zooming should be performed only when needed. 

Hybrid Recon 5.0 - Neurología 

Las rotaciones y el Zoom requieren interpolación, lo que reduce la resolución. Por lo 

tanto, las rotaciones y el Zoom se deben realizar solo cuando sea necesario. 
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Póngase en contacto con cualquiera de las direcciones que se indican a continuación para 

solicitar servicio técnico, asistencia o para resolver cualquier otra pregunta. 

    

Sede corporativa 

Hermes Medical Solutions AB  
Strandbergsgatan 16            

112 51 Estocolmo  

SUECIA  

Tel.: +46 (0) 819 03 25  

www.hermesmedical.com  

Dirección de correo electrónico general: 
info@hermesmedical.com   

  

Direcciones de correo electrónico de soporte: 
support@hermesmedical.com   

support.ca@hermesmedical.com    

support.us@hermesmedical.com   

 Representantes  
  

Responsable en el Reino Unido  
Hermes Medical Solutions Ltd.  

Cardinal House  

46 St. Nicholas Street  

Ipswich, IP1 1TT  

Inglaterra, Reino Unido  

Representante autorizado en Suiza

 
CMI-experts  

Grellinger Str. 40  

4052 Basilea  

Suiza  

  

Hermes Medical Solutions Ltd. 
York Suite, 7-8 Henrietta Street  

Covent Garden  

Londres WC2E 8PS  

Reino Unido  

Tel.: +44 (0) 20 7839 2513  

  

Hermes Medical Solutions, Inc   
710 Cromwell Drive, Suite A  

Greenville, NC27858  

EE. UU.  

Tel.: +1 (866) 437-6372  

Fax: +1 (252) 355-4381  

  

Hermes Medical Solutions Canada, Inc  
1155, René-Lévesque O., Suite 2500  

Montreal (QC) H3B 2K4  

Canadá  

Tel.: +1 (877) 666-5675  

Fax: +1 (514) 288-1430  

  

Hermes Medical Solutions Germany GmbH  
Robertstraße 4  

48282 Emsdetten  

Alemania  

Tel.: +46 (0)819 03 25  

  

  

4 INFORMACIÓN DE CONTACTO 

4.1 Información de contacto del fabricante 

4.2 Representantes 

4.3 Filiales 

http://www.hermesmedical.com/
mailto:info@hermesmedical.com
mailto:support@hermesmedical.com
mailto:support.ca@hermesmedical.com
mailto:support.ca@hermesmedical.com
mailto:support.us@hermesmedical.com
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Puesta en marcha 

  

• Aboutbox y enlace a IFU. 

• Manuales del usuario. 

  

Interfaz de usuario 

  

• Corrección de movimiento. 

• Reorientar el estudio - cuando corresponda. 

• Corrección de atenuación (CT, Chang o mapa de atenuación sintético). 

• Aplicar filtro. 

• Reproyección – cuando corresponda. 

• Guardar resultados. 

• Iniciar visor. 

  

Configuración 

  

• Parámetros del protocolo. 

• Parámetros avanzados. 

• Calibración del SUV SPECT. 

  

Barra de herramientas 

  

• Conceptos básicos (triangular, desplazarse, rotar, crear ventanas). 

• Capturas de pantalla. 

  

Variación de reconstrucción 

  

• Estudio de ventanas multienergéticas. 

• Estudio de isótopos duales. 

• Con y sin corrección de atenuación. 

• CT – INTERNO vs. EXTERNO. 

• Estudio de múltiples posiciones. 

• Estudio en decúbito prono. 

• SUV SPECT. 

5 ANEXO 1 - CONTENIDO REQUERIDO PARA LA 
FORMACIÓN DE USUARIOS 
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Pueden ser solo advertencias o un cuadro de mensaje con la opción Aceptar o Cancelar. 
  

• Anatomical prior requires 256x256 acquisition matrix size for best possible performance. 

La anatomía previa requiere un tamaño de matriz de adquisición de 256x256 para obtener el 

mejor rendimiento posible. 

• Anatomical prior requires 256x256 acquisition matrix size for best possible performance. 

La anatomía previa requiere un tamaño de matriz de adquisición de 256x256 para obtener el 

mejor rendimiento posible. 

• Attenuation correction is not enabled or attenuation map is not available. 

La corrección de atenuación no está habilitada o el mapa de atenuación no está disponible. 

• Attenuation map is not available. 

El mapa de atenuación no está disponible. 

• Cannot normalize camera model name.  

No se puede normalizar el nombre del modelo de la cámara. 

• Cannot open collimator and ct parameter file.  

No se puede abrir el archivo de parámetros del colimador y de CT.  

• Cannot open isotope parameter file. 

No se puede abrir el archivo de parámetros isotópicos. 

• Cannot organise Interfiles according to time. 

No se pueden organizar los Interfiles según el tiempo. 

• Down-scatter simulation does not support fan-beam collimation.  

La simulación de dispersión descendente no admite la colimación de haz en abanico.  

• Dual isotopes with two half-lives require two or three energy windows.  

Los isótopos duales con dos vidas medias requieren dos o tres ventanas de energía.  

• Energy window info is not available or wrong.  

La información de la ventana de energía no está disponible o es incorrecta.  

• Error in 128x128 to 256x256 resampling.   

Error en el remuestreo de 128x128 a 256x256.   

• Error in allocating activity table.   

Error en la asignación de la tabla de actividades.   

• Error in anterior projection determination.   

Error en la determinación de la proyección anterior.   

• Error in determining projection angle in multi-bed study.   

Error en la determinación del ángulo de proyección en un estudio de múltiples posiciones.   

• Error in lateral projection determination.   

Error en la determinación de la proyección lateral.   

• Error in PSF energy settings. 

Error en la configuración de energía de PSF. 

• Error in reading image file.   

Error al leer el archivo de imagen.   

• Error in the starting angle. 

Error en el ángulo inicial. 

• FBP is not allowed with GPU. Modify your reconstruction protocol. 

FBP no está permitido con GPU.  

• Modify your reconstruction protocol.  

Modificar el protocolo de reconstrucción. 

• Fold-factor could not be found in MULTI_RES_FOLD_FACTOR.   

No se puede encontrar el factor de pliegue en MULTI_RES_FOLD_FACTOR.   

6 ANEXO 2 - MENSAJES DE ADVERTENCIA EN LA 
APLICACIÓN 
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• Full collimator modelling is not supported.   

No se admite el modelado completo del colimador.   

• Gated multi-isotope reconstruction is not allowed.   

No se permite la reconstrucción multiisótopos gatillada.   

• GPU reconstruction is not allowed with fan-beam collimator.   

No se permite la reconstrucción de GPU con el colimador de haz en abanico.   

• Header and PSF energy window settings do not match.   

Las configuraciones del encabezado y la ventana de energía PSF no coinciden.   

• Image position info is needed for knitting acquisition studies.   

Se necesita información sobre la posición de la imagen para los estudios de adquisición de 

tejido.   

• Image position information is missing.   

Falta información de la posición de la imagen.   

• Isotope does not match acquisition energy window settings.   

El isótopo no coincide con la configuración de la ventana de energía de adquisición.   

• Isotope does not match with number of acquisition energy windows. 

El isótopo no coincide con el número de ventanas de energía de adquisición. 

• Mismatch in rotation directions in whole body SPECT.   

Desajuste en las direcciones de rotación en la SPECT de cuerpo entero.   

• Necessary field missing in psf-header.   

Falta campo necesario en encabezado PSF.   

• Noisy study was created and saved to database.  

Se creó un estudio con ruido y se guardó en la base de datos.  

• Number of projection angles has to divisible with the number of subsets.  

El número de ángulos de proyección debe ser múltiplo del número de subconjuntos.  

• Number of projections is not divisible by the number of detector heads. 

El número de proyecciones no es divisible por el número de cabezales detectores. 

• Only 1-64 subsets are allowed.   

Solo se permiten entre 1 y 64 subconjuntos. 

• Radionuclide transmission scanning based mumap is no longer supported. 

El escaneo de transmisión de radionúclidos con base en mapa de atenuación ya no es 

compatible. 

• Radius of rotation info is not available. 

La información del radio de rotación no está disponible. 

• Reconstruction with full collimator model supports only 1 or 2 energy windows. 

La reconstrucción con el modelo de colimador completo solo admite 1 o 2 ventanas de energía. 

• Reconstruction with full collimator model with 2 energy windows is allowed only for dual 

I123/Tc99m reconstruction.   

La reconstrucción con modelo de colimador completo con 2 ventanas de energía solo está 

permitida para reconstrucción dual I123/Tc99m.   

• Scatter correction is not supported for acquisitions where energy windows have been 

summed.   

La corrección de dispersión no se admite en adquisiciones en las que se han sumado ventanas 

de energía.   

• Selected isotope and PSF isotope do not match.   

El isótopo seleccionado y el isótopo PSF no coinciden.   

• SPECT and CT frame of reference does not match.   

El marco de referencia de SPECT y CT no coincide.   

• Uniform attenuation map is not supported.   

No se admite el mapa de atenuación uniforme.   

• Unknown isotope-setting. 

Configuración de isótopos desconocida. 

• Unknown reconstruction method. 

Método de reconstrucción desconocido. 
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• Unknown slice orientation flag.   

Bandera de orientación de corte desconocida.   

• Unknown study type.   

Tipo de estudio desconocido.   

• Unknown transformation type in 2D registration.   

Tipo de transformación desconocido en registro 2D.   

• With byte-reverse sequence only 1, 2, 4, 8, 16, 32 or 64 subsets are allowed.   

Con secuencia de «bytes» inversos solo se permiten 1, 2, 4, 8, 16, 32 o 64 subconjuntos.   

• Acquisition with 720 degree extension of rotation is converted into a study with 360 

degree extension. Dual head system is assumed.    

La adquisición con una extensión de rotación de 720 grados se convierte en un estudio con una 

extensión de 360 grados.  

• Dual head system is assumed.  

Se asume un sistema de doble cabezal.    

• Cannot do multi-bed dual isotope decay correction. 

No se puede realizar la corrección de la desintegración dual de isótopos en múltiples posiciones. 

• Decay correction is not supported for this camera. 

Esta cámara no admite la corrección de descomposición. 

• Projections have not been decay corrected. To enable decay correction tick 1) Isotope 

string matching and 2) Decay correct projections buttons in the program parameters 

dialog.  

Las proyecciones no han sido corregidas por descomposición.  

Para habilitar la corrección de desintegración, hay que marcar los botones 1) Coincidencia de 

cadenas de isótopos y 2) Proyecciones de corrección de desintegración en el cuadro de diálogo 

de parámetros del programa.  

• Empty projection(s) detected. This might lead to reconstruction failure. 

Se detectaron proyecciones vacías. Esto podría llevar al error en la reconstrucción. 

• Isotope was not correctly detected.  

El isótopo no se detectó correctamente.  

• Patient names or ids do not match in all studies. 

Los nombres o identificaciones de los pacientes no coinciden en todos los estudios. 

• Projection maximum count is very low. This might lead to reconstruction failure.  

El recuento máximo de proyección es muy bajo. Esto podría llevar al error en la reconstrucción.  

• Several SPECT acquisition studies have been loaded. If you want to sum these and 

continue press OK otherwise press Abort to abort.    

Se han cargado varios estudios de adquisición SPECT. Si se quiere sumar estos y continuar 

presionar «OK», de lo contrario presionar «Cancelar» para cancelar.    

• Ventilation/perfusion string matching failed.  

Error en la correspondencia de las cadenas de ventilación y perfusión.  

 

  

Cardiología 

  

• Decay correction is not supported for this camera.  

Esta cámara no admite la corrección de descomposición.  

• Patient names or ids do not match in all studies. 

Los nombres o identificaciones de los pacientes no coinciden en todos los estudios. 

• Projection maximum count is very low. This might lead to reconstruction failure.  

El recuento máximo de proyección es muy bajo. Esto podría llevar al error en la reconstrucción.  

• Stress/rest/delay string matching failed. 

Error en la coincidencia de cadenas de estrés/descanso/retraso. 

• Stress/rest/delay/bloodpool string matching failed. 

Error en la coincidencia de cadenas de estrés/descanso/retraso/acumulación de sangre. 


